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6 testo 6610 probes 
Pos: 80 /TD/Überschriften/MUF/1.1/2.1/3.1 Leistungsbeschreibung @ 3\mod_1234258595211_79.doc @ 23951 @ 2 
 

6.1. Specifications 
Pos: 81 /TD/Leistungsbeschreibung/Verwendung/MUF63xx/Fühler 66xx @ 3\mod_1234427817811_79.doc @ 24713 @ 3444 
 

6.1.1. Functions and use 
The plug-in, adjusted probes from the testo 6610 family are used 
together with the testo 6383 transmitter. 
These measuring units are suitable for the following applications, 
for example: 
• Process instrumentation 
• Clean rooms 
• Test benches 
• Drying processes 
• Production and storage air quality 
• Complex room climate applications. 

6.1.1.1. Digital probes: 
The probes are adjusted in the factory and transmit their 
adjustment data to the internal memory of the testo 6383 
transmitter. The information is only transmitted between the probes 
and transmitter digitally. The probes can therefore be disconnected 
from the transmitter for adjustment or servicing while the transmitter 
itself can remain at the measuring point.  

 

 
Hint: We recommend in this case that a probe of the same 
type be inserted into the transmitter immediately in order to 
be able to continue measuring with minimal interruption. 

 

The transmitter identifies the probe and records that a probe was 
connected in the history. 

 

 
The testo 6383 transmitter can only be used with testo 
6610 probes. 

 

6.1.1.2. The Testo humidity sensor 
With the Testo humidity sensor, which has been in successful use 
and continually improved for more than ten years, the focus has 
from the very beginning been on both accuracy parameters, 
namely measuring uncertainty and long-term stability. 
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The capacitive humidity sensor is in principle a plate capacitor 
consisting of two electrically conductive plates (electrodes (1) and 
(2), see diagram below) opposite each other.  
A humidity-sensitive polymer (5) serves as the dielectric. The 
special feature lies in the perfect way the individual layers are 
matched to each other. This is evident particularly in the top 
electrode, which has to perform two tasks that, at first glance, 
appear contradictory: it must be completely permeable to the water 
vapour that is to be fed into the polymer dielectric, but at the same 
time it must be impervious, smooth and repellent to condensate, oil 
and dirt in order to protect the sensor. 

 

1 Cover electrode 
2 Bottom electrode 
3 Substrate (ceramic substrate for 

mechanical protection) 
4 Connections (protected against 

corrosion) 
5 Dielectric layer 

 
 

 
The humidity sensor cannot be exchanged by the customer 
(except for 6611). The humidity sensor may not be 
damaged or touched. Contamination and damage lead to 
an impairment of the measurement and the measuring 
accuracy. 

 

6.1.1.3. Self-diagnosis 
The probes in the testo 6610 range monitor their functionality 
themselves and report the following faults: 
• Sensor breaks 
• Sensor short-circuit 
• Condensation 

The condensation message is issued at a reading of 100 % RH 
and deactivated once the readings are within the valid range. 

• Error message with drift at the adjustment points 
• Value for relative humidity less than 0 % RH. 

The trigger threshold is set at -2 % RH. This means that an 
error message is only issued once a clear effect is discernible. 

• Early warning when sensor corrosion is starting to develop 
The testo 6617 probe is able to signal the first signs of 
corrosion. The probe can thus be changed at an early stage 
without interrupting the machine availability. 
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• Self-adjustment (testo 6615 only) 
• Excess temperature 

Error message if permissible process temperature is exceeded 
Pos: 82 /TD/Leistungsbeschreibung/Verwendung/MUF63xx/Aufbau Fühler Panel @ 5\mod_1257520069450_79.doc @ 52799 @ 3 
 

6.1.2. Design of the probe 
The probes of the testo 6610 family are made up of the following 
components (included in delivery): 
• Probe connector 
• Probe shaft with protection cap and sensors (% RH and °C or 

°F) 
• Probe cable bend radius minimum Ø 50 mm. 

 

 
1 Probe connector 
2 Probe length 
3 Probe  
4 Protection cap, sensor underneath 
5 Probe 
 

Pos: 83 /TD/Leistungsbeschreibung/Lieferumfang/MUF 63xx/Zubehör Fühler @ 3\mod_1235471914151_79.doc @ 26601 @ 3 
 

6.1.3. Accessories 
The following accessories are available for the probes from the 
testo 6610 family: 
• Filters and protection caps (see Protection caps, page 86) 
• Calibration certificate in accordance with ISO and DKD (see 

Accessories and spare parts, page 144). 
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Pos: 84 /TD/Überschriften/MUF/1.2/2.2 Produktbeschreibung @ 3\mod_1234258723551_79.doc @ 24008 @ 2 
 

6.2. Product description 
Pos: 85 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Übersicht Fühler Panel @ 4\mod_1252668114775_79.doc @ 50087 @ 34444  

6.2.1. Overview of probe and filter types 
6.2.1.1. Probe version 

A detailed description of the probe versions can be found from 
Integrated humidity probe, page 87 onwards. 
The following probe versions are available for the testo 6383 
transmitter: 

 

Version  Article no. Characteristic 
Integrated 
humidity 
probe 

KMAT option 
D04  
(0636 6610) 

Wall probe version; accuracy to ±1 % RH; 
temperature range -20 to +70 °C/-4 to +158 °F, 
plug-on sensor 

testo 6612 0555 6610-L12 Duct probe version; accuracy to ±1 % RH; 
temperature range -30 to +150 °C/ 
-22 to +302 °F, sensor soldered 

testo 6613 0555 6610-L13 Cable probe version; accuracy to ±1 % RH; 
temperature range -40 to +180 °C/ 
-40 to 356 °F, sensor soldered 

testo 6614 0555 6610-L14 Heated cable probe version; accuracy to ±1 % 
RH; temperature range -40 to +180 °C/ 
-40 to 356 °F, sensor soldered 

testo 6615 0555 6610-L15 Trace humidity cable probe version; accuracy to 
±6 K at -60 °Ctd; temperature range -40 to 
+120 °C/-40 to +248 °F, sensor soldered 

testo 6617 0555 6610-L17 Cable with cover electrode monitoring probe 
version; accuracy to ±1.2 % RH; temperature 
range -40 to +180 °C/ 
-40 to +356 °F, sensor soldered 

6.2.1.2. Determining the accuracy/measuring uncertainty 
The entries for the measuring uncertainty for the probe are 
determined in accordance with GUM (Guide to the Expression of 
Uncertainty in Measurement/DIN V ENV 13005). 
All parts that make up the measuring uncertainty given by Testo 
are listed below. When comparing the measuring 
uncertainty/accuracy between manufacturers, which components 
are included is to be taken into account. In many cases, not all 
elements that contribute to measuring uncertainty are assessed, for 
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example if the error contribution of the production adjustment for 
some manufacturers is shown separately or not at all. 
The measuring uncertainty of the probe includes the sensor and its 
electronics as well as the output of the digital measuring signal: 

 

1 Linearity including scatter Systematic error and scattering of the 
components (due to manufacturing 
tolerances) 

2 Hysteresis Hysteresis indicates the maximum deviation 
of the readings that are obtained when you 
set the same value for the parameter, once 
coming from a smaller value, once coming 
from a larger value (humidity sensors actually 
have no hysteresis, but rather very slow 
adjustment effects that appear to be 
hysteresis when considered only for a short 
period.) 

3 Reproducibility Repeatability (scattering of the readings in 
the event of the same parameter being 
entered successively) 

4 Production adjustment area The measuring uncertainty of the reference 
instruments of the adjustment area (including 
the reference instrument) in production 

5 Uncertainty of the testing Uncertainty of the procedure for determining 
points 1 and 2 

 

6.2.1.3. Ordering options for testo 6610 probe (0555 6610) 
 

Order code  Characteristic 
Lxx Probe type  
L12 Probe 6612 
L13 Probe 6613 
L14 Probe 6614 
L15 Probe 6615 
L17 Probe 6617 
Mxx Protection 
caps 

 

M01 Protection cap made of stainless steel 
M02 Protection cap made of wire mesh 
M03 Protection cap made of PTFE 
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Order code  Characteristic 
M04 Metal protection cap (open) 
M06 PTFE protection cap with condensate drip hole 
M07 Protection cap made of PTFE with condensate 

drip hole and condensation protector 
M08 Protection cap for H2O2 atmospheres 
Nxx Cable length  
N01 1 m cable length (testo 6613, 6614, 6615, 

6617) 
N02 2 m cable length (testo 6613, 6614, 6615, 

6617) 
N05 5 m cable length (testo 6613, 6614, 6615, 

6617) 
N10 10 m cable length (testo 6613, 6614, 6615, 

6617) 
N23 Cable length specifically for duct versions 

(testo 6612) 
Pxx Probe length  
P12 Probe length approx. 120 mm (testo 6613) 
P20 Probe length approx. 200 mm (testo 6612, 

6613, 6614, 6615, 6617) 
P30 Probe length approx. 300 mm (testo 6612, 

6613) 
P50 Probe length approx. 500 mm (testo 6612, 

6613, 6614, 6615, 6617) 
P80 Probe length approx. 800 mm (testo 6612, 

6613) 
 

6.2.1.4. Protection caps 
One of the following protection caps can be used for each probe 
version: 

 

Filter*  Article no. ** Characteristic Length A 
(mm) 

M01 0554 0647 Protection cap made of stainless steel 33 
M02 0554 0757 Protection cap made of wire mesh 40.3 
M03 0554 0759 Protection cap made of PTFE 35 



6 testo 6610 probes 

  87 

Filter*  Article no. ** Characteristic Length A 
(mm) 

M04 0554 0755 Metal protection cap (open) 35 
M06 0554 9913 PTFE protection cap with condensate 

drip hole 
35 

M07 0554 9913 + 
0554 0166 

Protection cap made of PTFE with 
condensate drip hole and 
condensation protector 

35 
55 

M08 0699 5867/1 Protection cap for H2O2 atmospheres 35 
 

* When ordering the probe, please use this protection cap code, cf. 
Ordering options for testo 6610 probes (0555 6610), page 150. 
** When purchasing a replacement (protection cap only), please 
use this order number. 

Pos: 86 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Integrierter Feuchtefühler @ 4\mod_1252670643128_79.doc @ 50151 @ 35555 
 

6.2.2. Integrated humidity probe 
The integrated humidity probe is mounted on the wall together with 
the ready-wired testo 6383 transmitter. 

At a glance 
 

1 Protection 
cap 

2 Probe shaft 
3 Key 

 

4 Connector 
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Application 
• Monitoring and regulating the air quality in clean rooms 

 

Technical data 
  

Parameters 
• Humidity (% RH/°Ctd/°Ftd) etc. 
• Temperature 
Measuring range 
• Humidity: 0 to 100 % RH 
• Temperature: -20 to +70 °C/-4 to +158 °F 
Material 
• Probe shaft: Stainless steel 
• Connector: ABS plastic 
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Accuracy (at 25 °C/77 °F)* 
• Humidity 

◦ ± (1.0 % RH + 0.007 x reading) for 0 to 90 % RH 
◦ ± (1.4 % RH + 0.007 x reading) for 90 to 100 % RH 
◦ 0.02 % RH/K, dependent upon the process temperature 

(with a deviation of 25 °C/+77 °F) 
◦ 0.02 % RH/K, dependent upon the electronics temperature 

(with a deviation of 25 °C/+77 °F) 
• Temperature 

◦ ±0.15 °C (0.27 °F) with slope PT1000 DIN 1/3 class B 
* Refer to the charts below for the correlation between 

temperature and accuracy. 
Reproducibility 
• Better than ±0.2 % RH 
Sensor 
Response time without protective filter: t 90 max. 15 s 
Probe dimensions 
• Diameter of probe shaft: 12 mm 
• L = approx. 47 mm 
• L – A = 32 mm 
• A, see Table Protection caps, page 86 

Measuring accuracy of the integrated humidity probe 
Humidity error, absolute |±% RH| as a factor of process humidity 
(% RH) 
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Temperature error as a factor of process temperature and 
temperature of electronics 

 
Grey line: System error 6383 + probe, electronics 25 °C/+77 °F 

Black line: System error 6383 + probe, electronics –25 to 70 °C/-13 to 158 °F 
Pos: 87 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Kabelfühler 6613 @ 3\mod_1235492739984_79.doc @ 26696 @ 35555  

6.2.3. testo 6613 cable probe 
The testo 6613 probe is used when the spatial separation of the 
transmitter and probe is required. 

At a glance 
 

1 Connector 
2 Key 
3 Probe cable 
4 Probe shaft 
5 Protection cap (including: 

humidity and 
temperature sensor) 

  

 

 WARNING 
In the event of overpressures, the probe may become a 
projectile. 
> Mount the probe pressure-tight (see pressure resistance 

under Technical data) 
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Application 
• Monitoring and regulating industrial humidity processes (apart 

from high-humidity processes), e.g. food production, storing fruit 
• Monitoring the production and storage air quality when 

manufacturing and storing hygroscopic products 
• Meeting the top accuracy requirements 
• Clean room applications 
• Applications for which a sturdy metal housing is required. 

 

 
Testo recommends that the testo 6614 (heated) probe be 
used for continuous high-humidity processes. 

 
 

  

Technical data 
Parameters 
• Humidity  
• Temperature 
Measuring range 
• Humidity: 0 to 100 % RH 
• Temperature: -40 to +180 °C/-40 to +356 °F 
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Material 
• Probe shaft: Stainless steel 
• Line: Sheathed, FEP 
• Connector: ABS plastic 
Accuracy (at 25 °C/77 °F)* 
• Humidity 

◦ ± (1.0 % RH + 0.007 x reading) for 0 to 90 % RH 
◦ ± (1.4 % RH + 0.007 x reading) for 90 to 100 % RH 
◦ 0.02 % RH/K, dependent upon the process temperature 

(with a deviation of 25 °C/+77 °F) 
◦ 0.02 % RH/K, dependent upon the electronics temperature 

(with a deviation of 25 °C/+77 °F) 
• Temperature 

◦ ±0.15 °C (0.27 °F) with slope PT1000 DIN 1/3 class B 
* Refer to the charts below for the correlation between 
temperature and accuracy. 

Reproducibility 
• Better than ±0.2 % RH 
Sensor 
• Response time without protective filter: t 90 max. 15 sec. 
Probe dimensions 
• Diameter of probe shaft: 12 mm 
• L = approx. 120/200/300/500/800 mm 
• L – A = 85/165/265/465/765 mm 
• A, see Table Protection caps, page 86 
Probe length incl. probe shaft and filter 
• 1/2/5/10 m 
Pressure resistance** 
• PN 10 (probe tip) 
• PN 1 (if end of probe/cable is involved in process) 
** If installing probe under pressure, please use cutting ring screw 
connection (order no. 0554 1795). 
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Measuring accuracy of testo 6613 cable probe 
Humidity error, absolute |±% RH| as a factor of process humidity 
(% RH) 

 

 

Temperature error as a factor of process temperature and 
temperature of electronics 

 
Grey line: System error 6383 + probe, electronics 25 °C/+77 °F 

Black line: System error 6383 + probe, electronics –25 to 70 °C/-13 to 158° F 
Pos: 88 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Beheizter Kabelfühler 6614 @ 3\mod_1235548799451_79.doc @ 26723 @ 35555  
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6.2.4. testo 6614 heated cable probe 
The testo 6614 heatable probe is suitable for use in high-humidity 
processes in which there is the possibility of condensation for the 
probe. 

 

 
Also see volume 1, High-humidity adjustment for testo 
6614, page 45 for the functional principle of the testo 6614. 

 

At a glance 
 

1 Connector 
2 Key 
3 Probe cable 
4 Probe shaft 
5 Filter (including: 

humidity and 
temperature sensor) 

6 Temperature probe  
7 Cable for 

temperature probe 
8 Condensation 

protector 
(0554 0166) 

  

 

WARNING
In the event of overpressures, the probe may become a 
projectile. 
> Mount the probe pressure-tight (see pressure resistance under 

Technical data) 
 

 

Application 
• Monitoring and regulating high-humidity processes, e.g. drying 

(ceramics, tobacco, wood, food) and maturing (cheese, fruit). 
• At flow velocities > 1 m/s, an additional measuring uncertainty, 

not higher than +1.5 % RH, is to be expected. To prevent this 
error and ensure the highest measuring accuracy: Use 
condensation protector 0554 0166. 
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1 testo 6383 
transmitter 

2 testo 6614 heated 
cable probe 

3 Temperature 
probe 

4 Assembly distance 
max. 10 cm 

 

Technical data 
Parameters 
• Humidity 
• Temperature 
Measuring range 
• Humidity: 0 to 100 % RH 
• Temperature: -40 to + 180 °C/-40 to 356 °F 
Material 
• Probe shaft: Stainless steel 
• Line: Sheathed, FEP 
• Connector: ABS plastic 
Accuracy (at 25 °C/77 °F)* 
• Humidity (values valid when using condensation protector 

0554 0166) 
◦ ± (1.0 % RH + 0.007 x reading) for 0 to 100 % RH 
◦ 0.02 % RH/K, dependent upon the process temperature 

(with a deviation of 25 °C/+77 °F) 
◦ 0.02 % RH/K, dependent upon the electronics temperature 

(with a deviation of 25 °C/+77 °F) 
• Temperature 

◦ ±0.15 °C (0.27 °F) with slope PT1000 DIN 1/3 class B 
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* Refer to the charts below for the correlation between 
temperature and accuracy. 

Reproducibility 
• ± 0.2 % RH better 
Sensor 
• Response time without protective filter: t 90 max. 15 sec. 
Probe dimensions 
• Diameter of probe shaft: 12 mm  
• Diameter of temp. probe: 3 mm 
• L = approx. 200/500 mm 
• L – A = 165/465 mm 
• A, see Table Protection caps, page 86 
Probe length incl. probe shaft and filter 
• 1/2/5/10 m 
Pressure resistance** 
• PN 10 (probe tip) 
• PN 1 (if end of probe/cable is involved in process) 
** If installing probe under pressure, please use cutting ring screw 
connection (order no. 0554 1795). 

Measuring accuracy of heated testo 6614 cable probe 
Humidity error, absolute |±% RH| as a factor of process humidity 
(% RH) 
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Temperature error as a factor of process temperature and 
temperature of electronics 

 
Grey line: System error 6383 + probe, electronics 25 °C/+77 °F 

Black line: System error 6383 + probe, electronics –25 to 70 °C/-13 to 158° F 
Pos: 89 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Restfeuchte-Kabelfühler 6615 @ 3\mod_1235549882844_79.doc @ 26742 @ 55555  

testo 6615 trace humidity cable probe (self-adjustment) 
The testo 6615 probe corrects deviations in measurements by 
means of self-adjustment. This has a particular significance with 
low humidity values (in dewpoint range). 

 

 
Also see volume 1, Self adjustment of testo 6615 trace 
humidity probe, page 46 for the functional principle of the 
testo 6615. 
Only use testo 6615 with sintered PTFE protection cap (art. 
no. 0554 0758) or sintered stainless steel protection cap 
(art. no. 0554 0647). 
During the self-adjustment phase the signal values of the 
analog outputs remain on hold, meaning they are frozen for 
the duration. 
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At a glance 
 

1 Connector 
2 Key 
3 Probe cable 
4 Probe shaft 
5 Protection cap 

(including: humidity 
and temperature 
sensor) 

 

 

WARNING
In the event of overpressures, the probe may become a 
projectile. 
> Mount the probe pressure-tight (see pressure resistance under 

Technical data) 
 

 

Application 
• Monitoring and regulating trace humidity processes 

(compressed air with adsorption or membrane driers and plastic 
granulate driers) 

• Used when spatial separation of transmitter and probe is 
required. 
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Technical data 
Parameters 
• Dewpoint  
• Temperature 
Measuring range 
• Dewpoint: -40 to + 30 °Ctd/-148 to +212 °Ftd 
• Temperature: -40 to ±120 °C/-40 to +248 °F 
• (Temp. durability up to +180 °C/+356 °F) 
Material 
• Probe shaft: Stainless steel 
• Line: Sheathed, FEP 
• Connector: ABS plastic 
Accuracy (at 25 °C/77 °F)* 
• Dewpoint 

◦ ± 1 K at 0 °Ctd/+32 °Ftd 
◦ ± 2 K at -40 °Ctd/-40 °Ftd 
◦ ± 4 K at -50 °Ctd/-58 °Ftd 
◦ ± 6 K at -60 °Ctd/-76 °Ftd 
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• Dependent on the process temperature (deviation of 25 °C / 
77 °F) 
◦ ± 0.1 Ktd/K at -40 °C to 25 °C/-40 °F to +77 °F 
◦ ± 0.2 Ktd/K at 25 °C to 50 °C/77 °F to 122 °F 
◦ ± 0.4 Ktd/K at 50 °C to 120 °C/122 °F to 248 °F 

• Temperature 
◦ ±0.15 °C (0.27 °F), slope PT1000 1/3 class B 
* Refer to the charts below for the correlation between 
temperature and accuracy. 

Sensor 
• Response time without protective filter: t 90 max. 15 sec. 
Probe dimensions 
• Diameter of probe shaft: 12 mm 
• L = approx. 200/500 mm 
• L – A = 165/465 mm 
• A, see Protection caps, page 86. 
Cable length incl. probe shaft and filter 
• 1/2/5/10 m 
Pressure resistance 
• PN 16 (probe tip)** 
** If installing probe under pressure, please use cutting ring screw 
connection (order no. 0554 1795). 
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Measuring accuracy of testo 6615 trace humidity cable probe 
Dewpoint error, absolute |±% RH| as a factor of process dewpoint 
(°Ctd) 

 

 

Temperature error as a factor of process temperature and 
temperature of electronics 

  

Grey line: System error 6383 + probe, electronics 25 °C/+77 °F 

Black line: System error 6383 + probe, electronics –25 to 70 °C/-13 to 158° F 
Pos: 90 /TD/Produktbeschreibung/Übersicht/MUF 63xx/Kabelfühler selbstüberwacht 6617 @ 3\mod_1235551132150_79.doc @ 26761 @ 355455 
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6.2.5. testo 6617 cable probe (self-monitoring) 
The testo 6617 probe is used if spatial separation of the transmitter 
and probe is required, particularly for media (gases, vapours) which 
can jeopardize/damage the humidity sensor (the testo 6617 has a 
self-monitoring and early-warning function for such applications). 

At a glance 
 

1 Connector 
2 Key 
3 Probe cable 
4 Probe shaft 
5 Filter (including: humidity 

and temperature sensor) 

 

 

WARNING
In the event of overpressures, the probe may become a 
projectile. 
> Mount the probe pressure-tight (see pressure resistance under 

Technical data) 
 

 

Application 
• Monitoring and regulating industrial humidity processes 

involving corrosive media (apart from high-humidity processes) 
with the exception of applications with HCL, HF and other acids 
and acidifiers in larger concentrations (SO2, SO3, NO2) 

• Meeting the top accuracy requirements 
• Applications for which a sturdy metal housing is required 

 

 
This probe does NOT have a longer life with exposure to 
aggressive media than the testo 6613, for example. 
However, early warning of damage to the sensor is given 
so that machine failures can be avoided. 
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6.2.5.1. Self-monitoring of cover electrode 
Use in harsh ambient conditions with aggressive media in some 
cases incurs the risk of damage to the sensor. 
Damage to the sensor is generally reflected by incorrect readings 
which occur a long time before the sensor is wrecked. If this 
damage to the sensor is not spotted until too late, high costs can be 
incurred due to unusable readings or machine shutdowns and 
waiting times until the sensor is replaced. 

1 Cover electrode 
2 Bottom electrode 
3 Substrate (ceramic 

substrate for mechanical 
protection) 

4 Connections (protected 
against corrosion) 

 

5 Dielectric layer 

The testo 6617 has a unique self-monitoring function. 
This allows early detection of damage to the sensor, e.g.: 
• Mechanical damage (e.g. scratches) 
• Damage from aggressive gases (e.g. acids in aerosol form) 
• Swelling or detachment of polymer layer due to effects of 

solvents 
Once the self-monitoring reaches the specific limit value, the probe 
warning message "Sensor early warning" is issued. 
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Technical data 
Parameters 
• Humidity (% RH/°Ctd/°Ftd) 
• Temperature 
Measuring range 
• Humidity: 0 to 100 % RH 
• Temperature: -40 to +180 °C/-40 to 356 °F 
Material 
• Probe shaft: Stainless steel 
• Line: Sheathed, FEP 
• Connector: ABS plastic 
Accuracy (at 25 °C/77 °F)* 
• Humidity 

◦ ± (1.2 % RH + 0.007 x reading) for 0 to 90 % RH 
◦ ± (1.6 % RH + 0.007 x reading) for 90 to 100 % RH 
◦ 0.02 % RH/K, dependent upon the process temperature 

(with a deviation of 25 °C/+77 °F) 
◦ 0.02 % RH/K, dependent upon the electronics temperature 

(with a deviation of 25 °C/+77 °F) 
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• Temperature 
◦ ±0.15 °C (0.27 °F) with slope PT1000 DIN 1/3 class B 
* Refer to the charts below for the correlation between 
temperature and accuracy. 

Reproducibility 
• Better than ±0.2 % RH 
Sensor 
• Response time without protective filter: t 90 max. 15 sec. 
Probe dimensions 
• Diameter of probe shaft: 12 mm 
• L = approx. 200/500 mm 
• L – A = 165/465 mm 
• A, see Protection caps, page 86. 
Probe length incl. probe shaft and filter 
• 1/2/5/10 m 
Pressure resistance 
• PN 10 (probe tip)** 
** If installing probe under pressure, please use cutting ring screw 
connection (order no. 0554 1795). 

Measuring accuracy of testo 6617 cable probe (self-
monitoring) 
Humidity error, absolute |±% RH| as a factor of process humidity 
(% RH) 
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Temperature error as a factor of process temperature and 
temperature of electronics 

 
Grey line: System error 6383 + probe, electronics 25 °C/+77 °F 

Black line: System error 6383 + probe, electronics –25 to 70 °C/-13 to 158° F 
Pos: 91 /TD/Überschriften/MUF/1.3/2.3 Inbetriebnahme @ 3\mod_1234258805768_79.doc @ 24027 @ 2  

6.3. Commissioning 
Pos: 92 /TD/Erste Schritte/MUF 63xx/Fühler Inbetriebnahme Panel @ 5\mod_1257518810864_79.doc @ 52735 @ 3455553 
 

6.3.1. Installing the probe 
6.3.1.1. Installing testo 6613/6614/6615/6617 probes 

If used with these probes, the testo 6383 transmitter is mounted on 
the wall, see volume 1, Fehler! Verweisquelle konnte nicht 
gefunden werden., page Fehler! Textmarke nicht definiert.. 
Install probe according to the application and the measuring and 
spatial conditions, cf. cases A1 to C below  

 

 
In processes with which condensate forms at the humidity 
probe, install the probe vertically (filter points downwards). 
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A 1 Wall mounting of probe 
 

 
1 Wall/duct holder (order no. 0554 6651) 
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A 2 Wall mounting of testo 6614 heated probe 
When mounting the testo 6614 heated probe version, the 
temperature probe must be secured as close to the humidity probe 
as possible (max. 10 cm). An appropriate assembly tool is supplied 
with the testo 6614. 

1 Wall/duct holder (order 
no. 0554 6651) 

2 testo 6614 
3 Distance of probe tips of 

humidity probe - 
temperature probe: As 
close as possible, but 
without touching 
(distance between 
probe tips max. 10 cm) 

4 Assembly tool, supplied 
with the wall/duct holder 
(order no. 0554 6651) 

 

5 Temperature probe 
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B Duct mounting of testo 6614 heated probe 
When mounting the testo 6614 heated probe version, the 
temperature probe must also secured at a distance of 
approximately 10 cm from the humidity probe. An appropriate 
assembly tool is supplied with the testo 6614. 

1 Wall/duct holder (order 
no. 0554 6651) 

2 testo 6614 

3 Temperature probe  
4 Assembly tool, supplied 

with the wall/duct holder 
(order no. 0554 6651) 

5 Direction of flow 
6 approx. 10 cm distance 

C Process mounting 
1 Cutting ring screw 

connection (order no. 
0554 1795) 

During installation, ensure that the probe cannot be damaged 
during operation. 

 

 
For the testo 6614 (heated probe version), please use the 
cutting ring screw connection, order no. 0400 6193, to 
assemble the temperature probe. 
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6.3.2. Connecting/removing the probe to/from the 
transmitter 
• Insert probe connector into socket of testo 6383 until it 

engages. The testo 6383 identifies which probe is connected. 
• To remove the probe, the lock release button on the probe must 

be pressed so that this can be removed. 
Pos: 93 /TD/Überschriften/MUF/2.4 Wartung und Reinigung @ 3\mod_1234258856939_79.doc @ 24046 @ 2  

6.4. Maintenance and cleaning 
Pos: 94 /TD/Produkt instand halten/MUF 63xx/Fühler Wartung und Reinigung Panel @ 5\mod_1257513733946_79.doc @ 52703 @ 34433 
 

6.4.1. Replacing filters/protection caps 
6.4.1.1. Replacing the filter/protection caps for wall version 
 

  

 

 
Do not damage the sensors when exchanging the filter/the 
protection cap and do not touch their surfaces! 

 

1. Unscrew defective filter/protection cap (2) from probe shaft (1). 
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2. Screw new filter/protection cap onto probe shaft. 
 

 
Screw on protection cap by hand, i.e. do not tighten it using 
a tool. 

 

6.4.1.2. Replacing the filter/protection cap for duct versions 
 

 
The following descriptions applies to these probes: 
• testo 6613 
• testo 6614 
• testo 6615 
• testo 6617 

 

  

 
Do not damage the sensor when exchanging the filter/the 
protection cap and do not touch its surface! 

 

1. Unscrew defective filter/protection cap (2) from probe shaft (1). 
2. Screw new filter/protection cap onto probe shaft. 

 

 
Screw on protection cap by hand, i.e. do not tighten it using 
a tool. 
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6.4.2. Cleaning the instrument and filter/protection cap 
• Only clean the instrument carefully with a moist cloth. 
• Do not use aggressive cleaning agents. 
• Do not use any solvents. 
• Unscrew cap or protection cap to clean, clean with compressed 

air and replace. Take care not to damage the sensor! 

6.4.3. Replacing the sensor 
Thanks to the probe concept (digital, plug-in), all probes can be 
changed in situ within seconds if necessary, generally without any 
interruption to the operation of the machine. 

 

 
To maintain the extremely high accuracy of the testo 6610 
probe, it is not possible for customers to change the sensor. 
Please contact your Testo Service team for this. 

 
Pos: 95 /TD/Überschriften/MUF/3 Parametrier-, Abgleich und Analysesoftware (P2A-Software) @ 3\mod_1234258523713_79.doc @ 23932 @ 1 
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7 Parameterizing, adjusting and analyzing 
software (P2A software) 

Pos: 96 /TD/Überschriften/MUF/1.1/2.1/3.1 Leistungsbeschreibung @ 3\mod_1234258595211_79.doc @ 23951 @ 2 
 

7.1. Specifications 
Pos: 97 /TD/Leistungsbeschreibung/Verwendung/MUF63xx/MUF 63xx P2A @ 3\mod_1234258967326_79.doc @ 24065 @ 355 
 

The P2A software is used for the parameterizing, adjustment and 
analysis of testo transmitters. The following applies: 
• Generally, all newer testo transmitters (as of 2007) are 

supported. 
• Included with every testo transmitter that is bought new is a CD 

that contains a free upgrade of the software, which includes the 
device drivers for all transmitters that can be attached at this 
time. 

• This upgrade can be downloaded at any time via the testo 
homepage "www.testo.com/Download/P2A". 

The software must only be bought one time, even for owners of 
several testo transmitters. 

7.1.1. Functions and use 
In the P2A software, two different file types are used: The 
instrument and the parameter file. 

Instrument file 
The parameters of a particular transmitter are stored in its so-called 
instrument file. Using this file, the parameters can be edited and the 
instrument can be tested and adjusted. 
Instrument files also contain the respective histories in addition to 
the parameter data, i.e. "log books" are kept for the previous 
parameterizations, adjustments and messages (see Transmitter 
history page 139). 

 

 
Instrument files are ".cfm" format files. 

 

Parameter file 
Parameter files are not tied to a specific individual transmitter and 
contain only parameter data/no history data. 
If you use various instruments of the same type, you can create 
parameter files once (e.g. by saving the appropriate instrument file 
as the parameter file) and transmit these onto the other 
instruments. 
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Parameter files are ".cfp" format files. 

 Pos: 98 /TD/Leistungsbeschreibung/Systemvoraussetzungen/MUF 63xx @ 3\mod_1234260654399_79.doc @ 24084 @ 3555 
 

7.1.2. System requirements 
Operating system 
• Windows® 2000 SP4 
• Windows® XP Home/Professional 
• Windows® Vista 

Computer 
• Pentium processor of at least 400 MHz or equivalent 
• 128 MB RAM 
• Graphics resolution of at least 1024 x 768  
• Unused hard drive capacity of at least 15 MB 
• CD-ROM drive 
• USB interface 
• At least Internet Explorer 5.0. 

Software 
The P2A software must be purchased and installed separately from 
the transmitter. If it is a new software version, the transmitter is 
already supported completely. Older P2A software versions can be 
updated via the P2A software upgrade (cf. product CD included 
with the transmitter). 

Pos: 99 /TD/Leistungsbeschreibung/Lieferumfang/MUF 63xx/MUF 63xx P2A @ 3\mod_1234260991646_79.doc @ 24103 @ 3 
 

7.1.3. Scope of delivery 
Included in the scope of delivery are: 
• P2A software 
• USB driver 

 

 
When working with the parameterizing, adjusting and 
analyzing software (P2A software), previous knowledge of 
Windows® operating systems is assumed. The description 
in this instruction manual relates to Windows® XP. 



7 Parameterizing, adjusting and analyzing software (P2A software) 

  115 

 
Pos: 100 /TD/Überschriften/MUF/3.2 Erste Schritte @ 3\mod_1234258633304_79.doc @ 23970 @ 2  

7.2. First steps 
Pos: 101 /TD/Erste Schritte/MUF 63xx/P2A/Software/Treiber installieren @ 3\mod_1234261192065_79.doc @ 24123 @ 3444 
 

7.2.1. Installing the software/driver 
 

 
Administrator rights are required to install programs and 
drivers under Windows® 2000 SP4, XP and Vista. 

 

7.2.1.1. Installing P2A software 
1. Insert CD with P2A software.  

✓  If the installation program does not start automatically: 

> Open Windows Explorer and start the file Setup.exe on the 
product CD. 

2. Follow the directions of the installation wizard. 

7.2.1.2. Installing USB driver 
 

 
Before installing the USB driver, please read the separate 
documentation that is enclosed with the USB driver CD. 

 

7.2.1.3. P2A software upgrade 
1. Insert product CD (supplied with the transmitter). 
2. Open Windows® Explorer and start the file P2A upgrade.exe 

on the product CD. 
3. Follow the directions of the installation wizard. 

Pos: 102 /TD/Erste Schritte/MUF 63xx/P2A/Software starten @ 3\mod_1234261605199_79.doc @ 24142 @ 3444 
 

7.2.2. Starting the software 
7.2.2.1. Starting the program 

> Select: [Start] > All Programs > Testo > P2A Software. 
- The program window is opened (see User interface page 116). 

7.2.2.2. Establishing a connection with the instrument 
Multiple instruments can be attached, however only one connection 
is active at all times. 

✓  USB driver is installed (see Installing USB driver page 115). 

1. Start the P2A software. 
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2. Connect adapter (supplied with the P2A software) to the service 
interface of the instrument (see volume 1, Service interface 
page 15). 

3. Connect instrument/adapter to the PC via the USB interface. 
- The instrument file of the attached instrument is shown in the 

file list. 

7.2.2.3. Activating the connection with the instrument 
> Click on the desired instrument file. 
- The selected file is marked in colour and the connection with 

the instrument is activated. 
If a connection with the instrument is established when the program 
is started, the corresponding instrument file is marked 
automatically. 

Pos: 103 /TD/Überschriften/MUF/3.3 Software verwenden @ 3\mod_1234258679599_79.doc @ 23989 @ 2  

7.3. Using the software 
Pos: 104 /TD/Produkt verwenden/MUF 63xx/P2A/Software verwenden @ 3\mod_1234262654547_79.doc @ 24162 @ 3 
 

7.3.1. User interface 
 

  

1 Menu bar: 
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Menu  Command  Explanation 
File Open Shows the Windows dialogue for 

searching and opening files. 
 Save as Saves the parameters of an 

instrument or parameter file 
under a new name. 

Edit Copy Copies the parameters of the 
marked instrument or parameter 
file in the cache. 

 Paste Pastes the parameters from the 
cache in the marked instrument 
or parameter file. 

View Toolbar 
Status bar 

Activates/deactivates the toolbar 
or status bar. 

? Check instrument 
connections 

Checks the connections to a 
connected instrument without the 
instrument having to be 
activated. 

 Service A text file with the most important 
information on the computer and 
the software is opened via 
Display service data. 

 Information Shows the version number of the 
P2A software. 

 
 
 

2 Toolbar: Shows the Windows-compliant icons for editing. 
3 File: 

 

Icon  File Explanation 

 
Symbol shows a 
transmitter 

Instrument 
file 

Instrument file 
Connection to the instrument has 
been established. 
<Type> <Serial number>.cfm 
File name should not be 
changed. 

 
Symbol shows a 
transmitter with a red 
minus sign in the upper 
left corner 

Instrument 
file 

Instrument file 
Connection to the instrument has 
not been established. 
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Icon  File Explanation 

 
Symbol shows a 
transmitter with a white 
P for parameter file in 
the upper left corner 

Parameter 
file 

<Type> <Serial number> 
<Date> <Time>.cfp 
File name can be changed. 
The name can be selected freely, 
but it is recommended that you 
retain the reference to the 
instrument. 
Parameter files are always 
marked red; the parameter 
values they contain are only 
forwarded to the instrument after 
being transmitted to the 
instrument file. 

 

4 Function buttons: Dialogues on editing and testing the 
instrument are opened by means of the buttons. 

[Change parameterization] see Changing instrument/parameter 
file page 119  
[Test/analyze transmitter] see Chapter Analyzing/testing the 
transmitter page 130 
[Adjusting the transmitter] see Chapter Adjusting the transmitter 
page 135  
[Transmitter history] see Transmitter history page 139  
5 File information: 

 

Status  Shown in the window  
An instrument file is 
selected 

Type, serial number, firmware version of the 
instrument. 

A parameter file is 
selected 

Type, serial number and firmware version of 
instrument for which the parameter file was 
created. 

Connection status Green = connection is active 
Red = connection is inactive 

 

6 Status bar: Shows the current status when editing via the menu 
bar. 
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Pos: 105 /TD/Produkt verwenden/MUF 63xx/P2A/Geräte-/Parameterdatei bearbeiten @ 3\mod_1234358080444_79.doc @ 24303 @ 34 
 

7.3.2. Editing instrument/parameter file 
7.3.2.1. Changing instrument/parameter file 

✓  The desired instrument/parameter file is marked. 

1. Click on [Change parameterization]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Change parameterization register. 
If the parameters were transmitted from other parameter files into 
the instrument file, a message is shown with which you can 
transmit the new parameters to the connected instrument using 
[Yes]. 

> If the parameters should not be transmitted, click on [No]. 
2. Change or enter parameters in the corresponding fields. 

Pos: 106 /TD/Produkt verwenden/MUF 63xx/P2A/Einheit / Analogausgang @ 3\mod_1234366217517_79.doc @ 24592 @  
 

Field Explanation 
Unit/ 
Analog output 

All analog outputs are parameterized in this 
mask. 
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Field Explanation 
Unit/analog output 
(graphic) 

Unit: 0 to 1 V/5 V/10 V or 0 to 20 mA/4 to 
20 mA. 
Vertical: Current version of the analog output 
(cannot be changed). 
Horizontal: Min./max. scale end points of 
selected unit. 
The curve changes in accordance with the 
entered value of scale minimum and 
maximum. 

Scale minimum/ 
maximum 

The endpoints of the scaling can be selected 
up to the stored scale minimum and 
maximum. In the process, scaling can take 
place beyond the measuring range in order 
to adjust the analog output to the customer 
system, see volume 1, Scaling, page 17 

Unit Selection of the physical unit. 
When changing the unit, standard values are 
set for scale minimum and maximum. 
Caution! 
When changing the phys. unit, the relay limit 
values are set to the assigned default values. 

Signal delay 
(graphic) 

Curve changes according to the set signal 
delay. 

Signal delay Time interval in stages 1 – 15: 
1 = no delay 
15 = longest delay. 
The signal delay is added to the reaction time 
of the sensor. The signal delay shows 
averaging over the time interval of the 
selected stage in seconds: 
Example 
Stage 10 = average of the readings from the 
last 10 seconds. 

 
 

 
The delay of the signal in relation to the change in the 
process is also significantly influenced by the selection of 
the particle filter. 
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Pos: 107 /TD/Produkt verwenden/MUF 63xx/P2A/Grenzwerte Relais  @ 3\mod_1234366741293_79.doc @ 24611 @   

Field  Explanation 
Limit values, relay 1 to 4/alarm 
values, alarm 1 to 4 

In this mask, the relays or display 
alarms are parameterized. 

Relay x/alarm x Four relays or alarm values are 
available (optional). 

Not used Relay is not used. 
Hysteresis image and input 
options are hidden. 

Collective alarm A relay can be used as a collective 
alarm detector in the event that 
selected messages appear. 
Selection of the messages (OR 
linkage) by selecting the 
checkbox. 

Min control If switched to ON (NO contact) or 
OFF (NC contact) under the limit 
value; in the event of a 
subsequent exceeding of Limit 
value plus Hysteresis, it is 
switched to OFF (NO contact) or 
ON (NC contact). 
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Field  Explanation 
Max control If switched to ON (NO contact) or 

OFF (NC contact) above the limit 
value; in the event of a 
subsequent undershooting of 
Limit value minus Hysteresis, it 
is switched to OFF (NO contact) or 
ON (NC contact). 

 
  

 
The graphic display in the centre of the screen refers to 
the relay wiring as a NO contact (ON). 

  

Hysteresis To avoid switching cycles. 
Channel Selection of the channel that is to 

be monitored. 
Limit value Values for the limits of the unit 

selected in Unit/analog output; 4 
decimal places. 
When changing the phys. unit, the 
relay limit values are set to the 
default values. 

Visual alarm display Checkbox is activated: Upon the 
appearance of the selected alarm, 
the background lighting of the 
display flashes. 
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Field  Explanation 
Alarm delay The desired alarm delay for the 

alarms of the min/max control and 
the visual alarm is entered in the 
input field (0 to 240 seconds 
possible).  
The alarm delay has no effect on 
the collective alarms. 

 Pos: 108 /TD/Produkt verwenden/MUF 63xx/P2A/Grundeinstellungen 638x @ 3\mod_1234367261131_79.doc @ 24649 @  
 

Field  Explanation 
Basic settings Setting the absolute pressure and selection 

of the H2O2 evaporation process for the 
parameter °Ctm). 

Absolute pressure The absolute pressure is included in the 
calculation of the following units: 
• °Ctd or °Ftd 
• g/kg or gr/lb 
• ppmV% vol. 
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Field  Explanation 
H2O2 process The calculation of the mixture dewpoint unit 

°Ctm is dependent upon the type of the 
evaporation process: 
• passive: H2O2 solution evaporates (via 

H2O2 water) 
• active: H2O2 solution is evaporated over a 

heated metal plate (with evaporated 
H2O2) 

• Input field: Entering the weight proportion 
of the liquid H2O2 compared to water in 
%. 

 
Pos: 109 /TD/Produkt verwenden/MUF 63xx/P2A/Ethernet Panel @ 4\mod_1252315394164_79.doc @ 48509 @   

Button  Explanation 
Ethernet Networking the transmitters via Ethernet. For 

a multitude of applications, measurement 
data can be simultaneously recorded, 
documented and visualized. 

 
Start wizard... Address allocation of the testo 6383 with 

Ethernet module: 
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Button  Explanation 

 
IP address Transmitter IP address 

  

 
Prior to the automatic allocation of the IP 
address, the network cable must be connected 
to the transmitter. 

  

IP address of the 
device 

Address allocation of the testo 6383 with 
Ethernet module: 

Manual • Define the IP address of the transmitter 
• Enter netmask 
• Enter gateway 

Automatic Automatic allocation of the IP address 
  

# 
Pos: 110 /TD/Produkt verwenden/MUF 63xx/P2A/Display @ 3\mod_1234424330866_79.doc @ 24673 @   
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Field  Explanation 
Display Setting the display functions (if a display is 

available on the transmitter). 

 
Continuous display 
lighting 

Display lighting is permanently switched on. 

Display lighting 
when button is 
pressed 
(10 seconds) 

When a particular button on the instrument is 
pressed, the display lights up for 10 seconds. 

Display brightness 
(0 to 9) 

Setting the brightness between 0 and 9: 
0 = dark 
9 = light 

Display contrast 
(0 to 9) 

Setting the contrast between 0 and 9: 
0 = low contrast 
9 = high contrast 

Display of the error 
messages 

Selection of whether the error messages 
should be shown in the display. 

Display language Selection of the language. 
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Field  Explanation 
New password The password consists of four numbers, 

each of which must be between 1 and 9.  
If the password protection is not to be used, 
the numerical code "0000" must be entered. 

[Adopt new 
password] 

Button for confirming the new password. 

Valid password Display of the current password. 
 Pos: 111 /TD/Produkt verwenden/MUF 63xx/P2A/Nullungszyklus @ 3\mod_1235995952936_79.doc @ 27005 @  
 

Field  Explanation 
Zeroing cycle Setting the interval of the automatic zeroing 

with solenoid valve. 

  

 
The accuracy specifications are only valid for the zeroing 
cycle of 15 sec set by the factory.  

  

Zeroing cycle setting Selection of the time interval after which the 
automatic zeroing cycle is to occur. 
Recommendation: 15 sec 
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Pos: 112 /TD/Produkt verwenden/MUF 63xx/P2A/Selbstabgleich 6615 @ 5\mod_1256826980426_79.doc @ 52583 @ 5 
 

Field  Explanation 

Self-adjustment 
Setting the self-adjustment. 

 
Activate self-
adjustment for the 
testo 6615 probe  

• Checkbox is activated: The self-
adjustment is performed in the set cycle.  

• Checkbox is not activated: The self-
adjustment is not performed. 

Self-adjustment 
every 

Setting the cycletime in which the self-
adjustment is to be performed. 

  

 
In order to receive reliable readings 
during the calibration or equalization 
period of the probe, testo 
recommends the shortest possible 
cycle time.  
A longer cycle time can be set in 
continuous operation. 
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Pos: 113 /TD/Produkt verwenden/MUF 63xx/P2A/Parameter speichern @ 3\mod_1234358425697_79.doc @ 24322 @ 4 
 

7.3.2.2. Saving parameters 
Parameters can be saved in new parameter files. 
1. Mark instrument/parameter file. 
2. Click on File > Save as in the menu bar. 
3. Select storage location and enter the file name. 
4. Click on [Save]. 
- The new parameter file is shown in the file list. 
Only the parameters are saved from an instrument file; the history 
data are not adopted. 

 

 
The original name (Instrument type, Serial number) is 
suggested with the current date/time as standard, e.g. 
"testo 6383 01234578 061120 1403.cfp". 
For a standard installation, the files are saved under 
"C:\Documents and Settings\All Users\Shared 
Documents\P2A Software". The path can differ depending 
on the version of the operating system. 

 
Pos: 114 /TD/Produkt verwenden/MUF 63xx/P2A/Parameterdatei öffnen @ 3\mod_1234358634164_79.doc @ 24341 @ 4  

7.3.2.3. Opening the parameter file 
All parameter files stored in the standard directory path are 
automatically displayed in the file list when the software is started. 
You can also open parameter files that are stored in other 
directories. 
1.  Click on File > Open in the menu bar. 
2. Select the storage location and click on the requisite file. 
3. Click on [Open]. 
- The selected file is opened. This can be changed and saved 

(see Editing instrument/parameter file page 119). 
Pos: 115 /TD/Produkt verwenden/MUF 63xx/P2A/Parameter kopieren/einfügen @ 3\mod_1234358826054_79.doc @ 24360 @ 4 
 

7.3.2.4. Copying and pasting parameters 
The parameters of a parameter file can be transmitted to an 
instrument file or another parameter file from the same instrument 
type. 
1. Select file from which parameters are to be copied. 
2. Click on Edit > Copy in the menu bar. 
3. Select the file which is to be modified. 
4. Click on Edit > Paste in the menu bar. 
- The parameters are transmitted to the file. 
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You can also use the common keyboard shortcuts for 
copying (CTRL+C) and pasting (CTRL+V). 
Parameters can also be transmitted using drag & drop, 
where you drag the icon of the parameter file onto the icon 
of the target instrument file. 

 

5. Connect and select corresponding instrument. 
6. Click on [Change parameterization]. 
7. Confirm confirmation request. 
- Parameter data are transferred to the instrument. 

 
 
Pos: 116 /TD/Produkt verwenden/MUF 63xx/P2A/Geräte-/Parameterdatei löschen @ 3\mod_1234359025194_79.doc @ 24379 @ 4  

7.3.2.5. Deleting instrument/parameter file 
Instrument/parameter files can be deleted from the file list. 
1. Click on the file that is to be deleted with the right mouse button. 
2. Select the command Delete in the context menu. 
- The instrument or parameter file is deleted from the list. 

Pos: 117 /TD/Produkt verwenden/MUF 63xx/P2A/Gerätedatei erzeugen @ 3\mod_1237206865717_79.doc @ 29703 @ 4  

7.3.2.6. Creating a new instrument file 
It is possible to create an instrument file without restarting the P2A 
software. 

✓  Transmitter must be connected. 

1. Click on File > New connection in the menu bar. 
- Connection to the transmitter is established. 

Pos: 118 /TD/Überschriften/MUF/x.x.x Messumformer analysieren / testen @ 3\mod_1237380874787_79.doc @ 29928 @ 3 
 

7.3.3. Analyzing/testing the transmitter 
Pos: 119 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer analysieren/testen 638x @ 3\mod_1237380071808_79.doc @ 29907 @ 4 
 

In this section, you can test the outputs of the connected 
instrument, read off the limit values and reset the parameters to the 
factory settings. 
The function is only available for instrument files. 

7.3.3.1. Analyzing/testing the instrument 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Perform action: 
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Action  Explanation 
Carrying out factory 
reset 

Reset the unit, limit value and hysteresis 
parameters to factory settings (see below). 

Testing analog 
output 

Test channel 1/optional 2/3 (see Testing 
analog output, page 131). 

Test switch outputs Manually switch relays 1 to 4 to test for 
proper function (see Testing switch output 
relays 1 to 4, page 133). 

Display min./max. 
values 

Overview of the minimum and maximum 
values measured since the last reset of the 
transmitter (see Displaying min./max. values, 
page 134). 

 

3. Click on [OK] or [Cancel] to close the dialogue. 
Pos: 120 /TD/Produkt verwenden/MUF 63xx/P2A/Werksreset durchführen @ 3\mod_1237379864072_79.doc @ 29887 @ 4 
 

7.3.3.2. Carrying out factory reset 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark transmitter test. 
- Current operating hours are shown. 
3. Confirm control query to perform the reset. 
- The values are reset to the customer-specific factory settings. 
4. Click on [OK] or [Cancel] to close the dialogue. 

Pos: 121 /TD/Produkt verwenden/MUF 63xx/P2A/Analogausgang testen 638x @ 3\mod_1234360201576_79.doc @ 24417 @ 4 
 

7.3.3.3. Testing analog output 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark channel and test values. 

 

Field/button Explanation 
 Check the analog outputs (see volume 

1, Editing Main Menu Analysis page 
58). 
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Field/button Explanation 

 
Current reading Readings are updated every second. 
Unit Unit according to the type of analog 

output. 
Default value Freely definable output value for the 

respective type of analog output (V or 
mA), 1 decimal place. 

[Activate] The entered default value is forwarded 
to the corresponding analog output 
and to the test contacts by clicking. 
A warning informs that the value is 
being transmitted to the connected 
instrument in the event of existing 
cabling. 
Now check the analog output using a 
precise multimeter. 

[Deactivate] Finish entering the electrical variables 
at the analog output. 
The analog output returns to the 
current reading again. 

 

3. Click on [OK] or [Cancel] to close the dialogue. 
- The analog output and the relay return to Measuring Mode 

again. 
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Pos: 122 /TD/Produkt verwenden/MUF 63xx/P2A/Schaltausgang Relais testen 638x @ 3\mod_1234361855542_79.doc @ 24436 @ 4 
 

7.3.3.4. Testing switch output relays 1 to 4 
✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark Relay tests and test the values. 

 

Field/button  Explanation 
 Test the relay function (see volume 1, Editing 

Main Menu Analysis, page 58). 

[Activate relay n] Close contact. 
A warning informs that the value is being 
transmitted to a connected PLC, external 
display, etc. in the event of existing cabling. 

[Deactivate relay 
n] 

Open contact. 
A warning informs that the value is being 
transmitted to a connected PLC, external 
display, etc. in the event of existing cabling. 

 

3. Click on [OK] or [Cancel] to close the dialogue. 
- The analog output returns to Measuring Mode again. 
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Pos: 123 /TD/Produkt verwenden/MUF 63xx/P2A/Min-/Max-Werte anzeigen 638x @ 3\mod_1234362220298_79.doc @ 24455 @ 4 
 

7.3.3.5. Displaying min./max. values 
The transmitter saves the minimum or maximum value for each 
channel (measured since the last voltage supply or since the last 
manual reset). 

✓  The required instrument file is marked. 

1. Click on [Test/analyze transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Test/analyze transmitter register. 
2. Mark Min./max. values. 

 

Field/button  Explanation 
Min./max. values View the min./max. values of each channel. 

Only the values within the measuring range 
are shown. 

 
Channel Min./max. of channel 1/2/3 (optional) 
Value Min. or max. value, 1 decimal place. 
Unit Unit selected in Unit/analog output. 

 

3. Reset Min./max. values. 
4. Click on [Reset min./max. values]. 
5. Confirm control query to perform the reset. 
- The values are reset to the factory settings. 
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6. Click on [OK] or [Cancel] to close the dialogue. 
Pos: 124 /TD/Überschriften/MUF/x.x.x Messumformer abgleichen @ 4\mod_1244530152797_79.doc @ 44885 @ 3  

7.3.4. Adjusting the transmitter 
Pos: 125 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer abgleichen 6383/6385 @ 4\mod_1252506602857_79.doc @ 49417 @  
 

This function is used to adjust an attached instrument. The 
following adjustments may be carried out using the software: 
• 1-point adjustment (offset) 
• Analog adjustment (entry via assistant/wizard) 
• n-point adjustment (entry via assistant/wizard) 
Also see volume 1, Adjusting the instrument, page 39. 

Pos: 126 /TD/Produkt verwenden/MUF 63xx/P2A/1-Punkt-Abgleich @ 3\mod_1234362620176_79.doc @ 24493 @ 4 
 

7.3.4.1. 1-point adjustment 
 

 
The testo 400/650 with precision humidity probe (order no. 
0636 9741) is recommended as the reference measuring 
instrument for 1-point adjustment (offset) (see Adjusting 
testo 6383 using testo handheld instrument, page 41). 

 

1. Expose the reference measuring instrument and the instrument 
to be adjusted to the same constant conditions and wait for 
equalization period to lapse. 

2. Mark the instrument file of the connected instrument. 
3. Click on [Adjusting the transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Adjusting the transmitter register. 
4. Enter reference value and click on [Carry out 1-point 

adjustment]. 
5. Confirm confirmation request. 
- The adjustment is carried out. 



7 Parameterizing, adjusting and analyzing software (P2A software) 

136 

 

Field  Explanation 

 
°C/°F Selection of the unit; only for temperature 

adjustment. 
Current reading Reading in °C/°F or % RH. 

Readings are updated every second. 
Reference value Entry of the read-off value from the reference 

measuring instrument. 
Permissible entries: 
• max. 5 % RH deviation (sum of all 1-point 

adjustments) 
• max. 2 K (°C) deviation (sum of all 1-point 

adjustments) 
 

> Click on [Set offset to zero] to reset a transmitted reference 
value. 

- The current reading is used again. 
6. Click on [OK] or [Cancel] to close the dialogue. 

Pos: 127 /TD/Produkt verwenden/MUF 63xx/P2A/n-Punkt-Abgleich _638x @ 3\mod_1235996620305_79.doc @ 27043 @ 4  
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7.3.4.2. n-point adjustment 
1. Connect precision pressure sensor (see volume 1, n-point 

adjustment (pressure), page 44). 
2. Mark the instrument file of the connected instrument. 
3. Click on [Adjusting the transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Adjusting the transmitter register. 
4. Mark n-point adjustment. 
5. Click on [Start wizard …] and follow the instructions of the 

wizard. 
- The adjustment is performed when the wizard is closed. 

 

Field Explanation 

 
How much pressure 
is actually applied 

Required field: Entry of the value read off at 
the pressure sensor. 

 

 
The n-point adjustment must always be carried out to its full 
extent and in good time at all selected adjustment points.  

 
 

 
The number of adjustment points (3 to 6) is stored in the 
user menu of the transmitter and can only be changed via 
the P2A software. 
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 Pos: 128 /TD/Produkt verwenden/MUF 63xx/P2A/Analogausgang abgleichen _638x @ 3\mod_1237457385870_79.doc @ 30104 @ 4 
 

7.3.4.3. Adjusting the analog output 
1. Connect precision multimeter (see volume 1, Analog output 

adjustment, page 43). 
2. Mark the instrument file of the connected instrument. 
3. Click on [Adjusting the transmitter]. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Adjusting the transmitter register. 
4. Click on [Start wizard …] and follow the instructions of the 

wizard. 
- The adjustment is performed when the wizard is closed. 

 

Field Explanation 
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Field Explanation 
Default value The analog output value from the last 

performed adjustment is given at the output. 
Value of the factory adjustment: 
• Lower adjustment point: approx. 10 % of 

the max. value 
• Centre adjustment point: approx. 50 % of 

the max. value 
• Upper adjustment point: approx. 90 % of 

the max. value 
Measured analog 
value 

Required field: Entry of the value read off at 
the multimeter. 

 
Pos: 129 /TD/Überschriften/MUF/2.3.5 Messumformer-Historie @ 3\mod_1237373806926_79.doc @ 29846 @ 3  

7.3.5. Transmitter history 
Pos: 130 /TD/Produkt verwenden/MUF 63xx/P2A/Messumformer-Historie 6383/6385 @ 4\mod_1252504036475_79.doc @ 49157 @  
 

Parameterizations, adjustment processes and messages that have 
occurred are registered in the transmitter with an operating hours 
stamp. 
In the history overviews (explained later in more detail), past 
processes and events can be made visible. 

 

 
For parameter changes or adjustments that are performed 
directly at the instrument (via the user menu), "Transmitter" 
is entered in the User field and only the operating hour is 
entered in the Date/time field instead of operating 
hour/date/time. 
For entries that are performed using the P2A software, the 
name of the user logged into Windows appears in the User 
field, while the date/time and operating hour are shown in 
the Date/time field. 

 

1. Mark the instrument file of the connected instrument. 
2. Click on the [Transmitter history] button. 
- The Properties of <Instrument type> <Serial number> 

dialogue is opened with the Transmitter history register. 
3. Click on the required entry in the list to change the display. 
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Field Explanation 

 
Operating hours / 
date/time 

Operating hour/time stamp at which the 
change at the instrument was performed. 

User Name with which the user is logged into the 
operating system. 
"Transmitter" entry if the change was 
performed at the instrument. 

Comments Type of parameter change, e.g. "Unit of 
channel 1 from Pa to hPa". 
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Field Explanation 

Selection of adjustment histories: 1-point adjustments / Analog 
adjustments / n-point adjustments. 
Serial no. Probes Serial number of the probe. 

Probe operating 
hour 

Operating hour of the probe at which the 
change at the instrument was performed. 

User Name with which the user is logged into the 
operating system. 
"Transmitter" entry if the change was 
performed at the instrument. 

Reference value If no changes were performed, no value is 
displayed. 

Unit Unit during the adjustment. 

Reading 1-point adjustment: If no changes were 
performed, no value is displayed. 

Offset from 1-point adjustment: Value before the 
adjustment. 

Offset to 1-point adjustment: Value after the 
adjustment. 

Pressure 
specification 

n-point adjustment: Reference value set at 
the pressure sensor. 

Channel Analog adjustment: Channel 1 to n. 
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Field Explanation 
Specification Analog adjustment: Actual value. 

Multimeter Analog adjustment: Reference value set at 
the multimeter. 

Offset Analog adjustment: Deviation at time of 
adjustment. 

 
Selection of probe adjustment histories: 1-point adjustments / 2-
point adjustments / Error/status messages. 
Serial number Serial number of the transmitter to which the 

probe was connected at the time of the 
adjustment. 

Operating hour 
probe 

Operating hour of the probe at which the 
change at the instrument was performed. 

Unit Unit during the adjustment. 

Offset from 1-point adjustment: Value before the 
adjustment. 

Offset to 1-point adjustment: Value after the 
adjustment. 

Target value 2-point adjustment: Reference value. 
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Field Explanation 
Reading 2-point adjustment: Value before the 

adjustment. 
Difference 2-point adjustment: Difference determined by 

instrument between target value and reading.
Error/status 
messages 

Error/status messages: The error/status 
messages assigned to the probe. 

The table is shown only for error and status messages that were 
generated in the transmitter and were transferred and saved there 
via the connection to the P2A software. 
Operating hours Operating hour at which the message 

appeared in the instrument. 
Serial number Serial number of the instrument to which the 

message is assigned 
Message e.g. "Scaling changed". The scaling was 

changed. 
Type of message e.g. early warning, status message. 

 

> To print out the history data, click on [Print]. 
 

 
The printing job is automatically sent to the default printer 
for the operating system. 
With [Set up printer …] a different printer can be selected 
or the printout can be edited. 
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4. Click on [OK] or [Cancel] to close the dialogue. 
Pos: 131 /TD/Überschriften/8. Tipps und Hilfe @ 0\mod_1173789887985_79.doc @ 406 @ 1  

8 Tips and assistance 
Pos: 132 /TD/Überschriften/8.1 Fragen und Antworten @ 0\mod_1177402017078_79.doc @ 1093 @ 2 
 

8.1. Questions and answers 
Pos: 133 /TD/Tipps und Hilfe/Fragen und Antworten/MUF 635x @ 3\mod_1236607627223_79.doc @ 27543 @  
 

Question Possible causes/solution 
Connection to instrument 
cannot be established 

Check connection cable/plug contacts 

A message appears on the 
display 

See volume 1, Status, warning and 
error messages, page 64  

Malfunction (with and 
without display) 

Analysis using the P2A software, see 
Analyzing/testing the transmitter, page 
130  

When does a stable 
current reading appear? 

After approx. 20 seconds 

  

If we could not answer your question, please contact your dealer or 
Testo Customer Service. For contact details see the rear side of 
this document or the web page www.testo.com/service-contact 

Pos: 134 /TD/Überschriften/8.2 Zubehör und Ersatzteile @ 0\mod_1177402058734_79.doc @ 1102 @ 2 
 

8.2. Accessories and spare parts 
Pos: 135 /TD/Tipps und Hilfe/Zubehör und Ersatzteile/MUF63xx/Zubehör Ersatzteile MUF 6383/6385 @ 4\mod_1252396548483_79.doc @ 48673 @  
 

 
An overview of the probes that can be used with the testo 
6383 can be found in volume 1, Overview of probe and filter 
types, page 84. 

 
 

Description  Article no. 
Spare parts  
Integrated humidity probe 0636 6610 
Sealing frame 0554 6384 
Protection Cap for the built-in humidity probe 0554 6385 
Interface and software  
P2A software (parameterizing, adjusting, 
analyzing) incl. USB adapter 

0554 6020 

testo 400/650 adapter 0554 6022 
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Dewpoint measurement (only with testo 
6615) 

 

Preliminary filter to protect measurement 
chamber and sensors against contamination 

0554 3311 

Precision chamber with adjustable inflow 0554 3312 
Flow meter for measurement chamber for 
setting the specified inflow of the sensor 

0554 3313 

Cooling coil for process temperatures 
> 50 °C/122 °F (up to 200 °C/392 °F), only 
with precision measurement chamber 

0554 3304 

2 m PTFE tube with compressed air 
connections up to 140 °C/284 °F, max. 
9000 hPa, only with precision measurement 
chamber 

0699 2824 

Protection caps  
Protection cap made of stainless steel (for 
integrated probe 0636 6610) 

0170 0263 

Protection cap made of stainless steel 0554 0647 
Woven wire filter protection cap 0554 0757 
Protection cap made of PTFE 0554 0758 
Metal protection cap (open) 0554 0755 
PTFE protection cap with condensate drip 
hole 

0554 9913 

Protection cap made of PTFE with 
condensation protector and condensate drip 
hole 

0554 0166 

Protection cap for H2O2 atmospheres 0699 5867/1 
Hoses  
Silicone hose ID 4 transparent 0086 0001, sold by 

the metre 
TYGON hose ID 4.8 transparent 0086 0031, sold by 

the metre 
Silicone hose transparent, internal diameter 
2 mm, for test pressure connections 6383  

0086 0003, sold by 
the metre 

Supply  
Mains unit (desktop, wall-mounted) 0554 1748 
Mains unit (top-hat rail mounting) 0554 1749 
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Extension and calibration cable 0554 6610 
External display  
Process display for testo 54-2 AC.... 5400 7553 
Process display for testo 54-7 AC.... 5400 7555 
Calibration  
Standard ISO calibration certificate, 
transmitter only 

0520 1000 

Standard DKD calibration certificate, 
transmitter only 

0520 1200 

Standard ISO calibration certificate, 
transmitter + probes 

0520 0176 

Special ISO calibration certificate, transmitter 
+ probes 

0520 0066 

Standard DKD calibration certificate, 
transmitter + probes 

0520 0276 

Special DKD calibration certificate, 
transmitter + probes 

0520 0236 

ISO calibration certificate humidity, probes 0520 0076 
DKD calibration certificate temperature, 
probes 

0520 0261 

For a complete list of all accessories and spare parts, please refer 
to the product catalogues and brochures or look up our website at: 
www.testo.com 

 
Pos: 136 /TD/Tipps und Hilfe/Zubehör und Ersatzteile/MUF63xx/Bestelloptionen MUF 6383 @ 4\mod_1251701200773_79.doc @ 47633 @ 3  
 

8.2.1. Ordering options for testo 6383 transmitter (0555 
6383) 
Order code  Characteristic 
Axx Measuring range  
A01 0 to 50 Pa 
A02 0 to 50 Pa 
A03  0 to 100 Pa 
A04 0 to 500 Pa 
A05 0 to 10 hPa 
A21 -10 to 10 Pa 
A22 -50 to 50 Pa 
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Order code  Characteristic 
A23 -100 to 100 Pa 
A24  -500 to 500 Pa 
A25 -10 to 10 hPa 
Bxx Analog 
output/supply 

 

B02 0 to 1 V (4-wire, 24 V AC/DC) 
B03 0 to 5 V (4-wire, 24 V AC/DC) 
B04 0 to 10 V (4-wire, 24 V AC/DC) 
B05 0 to 20 mA (4-wire, 24 V AC/DC) 
B06 4 to 20 mA (4-wire, 24 V AC/DC) 
Cxx Display  
C00 Without display 
C02 With display/English 
C03 With display/German 
C04 With display/French 
C05 With display/Spanish 
C06 With display/Italian 
C07 With display/Japanese 
C08 With display/Swedish 
Dxx Integrated humidity 
probe 

 

D00 No humidity/temperature probe 
D04 Humidity/temperature probe integrated 

in panel 
D05 Preparation for external 

humidity/temperature probe testo 6610 
probe 

Exx Ethernet  
E00 Without Ethernet interface 
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Order code  Characteristic 
E01 With Ethernet interface 
Fxx Differential 
pressure unit7 

 

F01 Pa/Min/Max 
F02 hPa/Min/Max 
F03 kPa/Min/Max 
F04 mbar/Min/Max 
F05 bar/Min/Max 
F06 mmH2O /Min/Max 
F07 inchH2O /Min/Max 
F08 inch HG/Min/Max 
F09 kg/cm2 /Min/Max 
F10 PSI/Min/Max 
Gxx Optional analog 
output for humidity 
probe connection testo 
6610/units8 

 

G01 % RH/Min/Max 
G02 °C/Min/Max 
G03 °F/Min/Max 
G04 °Ctd/Min/Max 
G05 °Ftd/Min/Max 
G06 g/kg /Min/Max 
G07 gr/lb /Min/Max 
G08 g/m3 /Min/Max 
G09 gr/ft3 /Min/Max 
G10 ppmV/Min/Max 
G11 °Cwb/Min/Max 
G12 °Fwb/Min/Max 
G13 kJ/kg /Min/Max (enthalpy) 

                                                           
7  Scaling +/- 50 % of measuring range possible 
8  Only if D04 or D05 is selected 



8 Tips and assistance 

  149 

Order code  Characteristic 
G14 mbar/Min/Max (water vapour partial 

pressure) 
G15 inch H2O/Min/Max (water vapour partial 

pressure) 
G16 °Ctm (dewpoint for H202 mixture) 
G17 °Ftm (dewpoint for H202 mixture) 
G18 % vol 
Hxx Relay  
H00 Without relay 
H01 4 relay outputs, limit value monitoring 
H02 4 relay outputs, channel 1 limit values 

and collective alarm 
Ixx Units, channel 3 
(only if optional 
humidity probe 
connection is 
available)9 

 

I01 % RH/Min/Max 
I02 °C/Min/Max 
I03 °F/Min/Max 
I04 °Ctd/Min/Max 
I05 °Ftd/Min/Max 
I06 g/kg /Min/Max 
I07 gr/lb /Min/Max 
I08 g/m3 /Min/Max 
I09 gr/ft3 /Min/Max 
I10 ppmV/Min/Max 
I11 °Cwb/Min/Max 
I12 °Fwb/Min/Max 
I13 kJ/kg /Min/Max (enthalpy) 
I14 mbar/Min/Max (water vapour partial 

pressure) 

                                                           
9  Only if D04 or D05 is selected 
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Order code  Characteristic 
I15 inch H2O/Min/Max (water vapour partial 

pressure) 
I16 °Ctm (dewpoint for H202 mixture) 
I17 °Ftm (dewpoint for H202 mixture) 
I18 % vol 
Kxx Languages of 
instruction manual 

 

K01 German/English instruction manual 
K02 French/English instruction manual 
K03 Spanish/English instruction manual 
K04 Italian/English instruction manual 
K05 Dutch/English instruction manual 
K06 Japanese/English instruction manual 
K07 Chinese/English instruction manual 
K08 Swedish/English instruction manual 

C 
Pos: 137 /TD/Tipps und Hilfe/Zubehör und Ersatzteile/MUF63xx/Bestelloptionen Fühler Panel @ 4\mod_1254749738065_79.doc @ 51283 @ 3  

8.2.2. Ordering options for testo 6610 probes (0555 6610) 
Order code  Characteristic 
Lxx Probe type  
L12 Probe 6612 
L13  Probe 6613 
L14 Probe 6614 
L15 Probe 6615 
L17 Probe 6617 
Mxx Protection caps  
M01 Protection cap made of stainless steel 
M02 Protection cap made of wire mesh 
M03 Protection cap made of PTFE 
M04 Metal protection cap (open) 
M06 PTFE protection cap with condensate drip 

hole 
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Order code  Characteristic 
M07 Protection cap made of PTFE with 

condensate drip hole and condensation 
protector 

M08 Protection cap for H2O2 atmospheres 
Nxx Cable length  
N02 1 m cable length (testo 6613, 6614, 6615, 

6617) 
N03 2 m cable length (testo 6613, 6614, 6615, 

6617) 
N04 5 m cable length (testo 6613, 6614, 6615, 

6617) 
N05 10 m cable length (testo 6613, 6614, 

6615, 6617) 
N06 Cable length specifically for duct versions 

(testo 6612) 
Pxx Probe length  
P12 Probe length approx. 120 mm 

(testo 6613) 
P20 Probe length approx. 200 mm 

(testo 6612, 6613, 6614, 6615, 6617) 
P30 Probe length approx. 300 mm 

(testo 6612, 6613) 
P50 Probe length approx. 500 mm 

(testo 6612, 6613, 6614, 6615, 6617) 
P80 Probe length approx. 800 mm 

(testo 6612, 6613) 

 
=== Ende der Liste für Textmarke Inhalt === 
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